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Overview - MySQL to FileMaker

This document shows how to perform a MySQL to FileMaker migration project using FmPro

Migrator. This migration process includes the migration of Tables/Fields and data for all columns
except BLOB columns.

The MySQL to FileMaker conversion process works equally well on macOS or Windows, even
though most of the screenshots in this manual will be shown on macOS.

Revision 1
FmPro Migrator 9.37
8/31/2021

FmPro Migrator - MySQL to FileMaker Migration Procedure - 4



Step 1
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Step 1 - MySQL to FileMaker - Get Info

Click FileMaker Tab

A\elelV| @ FileMaker

FmPro Migrator

.com Solutions Ines j Chat now

FmPro Migrator will first open to the About tab. Click the FileMaker tab to select the
source/destination database types and enter connection info.
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Select MySQL as Source Database

@ FileMaker

/Users/dsimpson/Desktop/MySQL_Test/

Get Info

' Drag & Drop B

o example_fmp_dsn19
Admin

FileMaker 19 o example2_fmp_dsn

Admin

.com Solutions Inc: g Chat now

Select MySQL from the Source Database menu.

Browse
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Enter MySQL Database Connection Info

FileMaker

FmPro Migrator

/Users/dsimpson/Desktop/MySQL_Test/

Get Info '

\ MySQL B

FileMaker 19 ~; example2_fmp_dsn

il © B

.com Solutions Inc: 1 Chat now

After MySQL has been selected as the source database, the Step 1 Get Info icon and drop down
menu will change to MySQL

Enter the (1) Hostname, (2) Port, (3) Database Name, (4) Username, (5) Password for the MySQL
database server.

Note: The login security for the MySQL database needs to be configured to allow connections from
the computer running FmPro Migrator.
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FmPro Migrator Compatibility with MySQL 8

At this time, MySQL versions up to 5.7 are supported by FmPro Migrator.

FmPro Migrator 9.37 and earlier versions are not able to connectto MySQL 8 database servers.
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MySQL Tables List - Shown in Navicat

[ NON ) Navicat Premium
~N — -

s B e i & F 50 0 0 »
Connection New Query Table View Function Others User Query Backup Automation  Model Charts View
v LY mysql5_MBP16 Objects ‘« TH members@test (mysql5_... ‘ ] companies@t: ®

£ FFLOCATIONS2 »

g information_schema E‘é i g\ ﬁ Q -

g mysql Name Rows Data Length Engine U test
£ performance_schema 7 address_book 1 0.07 KB MyISAM u— Opened
§ sys @ asset_management2 5 264.20 KB MyISAM

> g ek % asset_management2_repeating 8 0.20 KB MyISAM

@ companies 6 0.30 KB MyISAM
> @Tables @ companies_2 0 0.00 KB MyISAM

@ contact_management 1 0.36 KB MyISAM

> [ views 7 contacts 1 77.27 KB MyISAM

> fx Functions ) contacts_uuid 2 30.03 KB MyISAM

» () Events fl locationtest 8 0.36 KB MyISAM

> B Queries fFH maintenance_record 3 10.74 KB MyISAM

> S @ members 30 3.26 KB MyISAM

- A members_3 3 0.40 KB MyISAM

= test2 M notes 1 0.11KB MyISAM

MySQL8_Docker_MBP15r2 A tol_assets 4 10313 KB MyISAM

mysql_dcsi_dreamhost @ tbl_assets_repeating 8 0.20 KB MyISAM

LN mysql.w7vm ] tbl_assets v1 4 0.21KB MyISAM

onrev_databases @ tbl_maintenance_records 7 0.76 KB MyISAM

Pg12_MBP15r2 @ tbl_value_list_data_items 2 0.04 KB MyISAM

o 1 tokens 2 0.96 KB MyISAM
$ Fm|aDEV1 Oracle Cloud @ users 2 0.29 KB MyISAM

20 tables

This screenshot shows the list of tables which will be imported into FileMaker Pro by FmPro

Migrator.
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Click Step #1 Get Info Button

FileMaker

/Users/dsimpson/Desktop/MySQL_Test/

Get Info ‘
MySQL

FileMaker 19 o example2_fmp_dsn
pami B

.com Solutions Inc: 1 Chat now

Click the Step #1 button, FmPro Migrator will read the table structure info from the MySQL
database.
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Importing MetaData

FmPro Mig
FileMaker Continue...

/Users/dsimpson/Desktop/MySQL_Test/

Get Info ‘

\ MySQL B

FileMaker 19 o example2_fmp_dsn
pamin I

.com Solutions Inc: 1 Chat now

FmPro Migrator displays an importing dialog, as itis reading the metadata from the MySQL
database. The yellow Continue button will be enabled once processing has been completed. Click
the Continue button to see the imported tables listed in the Migration Process window.
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MySQL Tables in Migration Process Window

Migration Pro

CFs

TOs GUI

m%&#‘

IELEEM  Relationships Value Lists Layouts  Scripts

Step 2:
Install the FileMaker

ODBC driver. .
companies

' ies 2
Create an ODBC comnanies

DSN matching the
DSN name listed in
the Table Details

! Original Fieldname PK |Auto-Increment [Next SN New Fieldname |

window. 1 middle_name middle_name
2 phonetic_last_name phonetic_last_nam

Turn on ODBC 3 name name
Sharing within 4 organization organization
FileMaker. 5 denartment department
Menu: File > Sharing
> ODBC/JDBC
Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Create Table
Not Started

Transfer Data

Not Started

Optional
|

Image
Transfer

The metadata for the 20 tables from the MySQL database server have been imported into FmPro
Migrator and displayed in the Migration Process window.
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Step 2

FmPro Migrator - MySQL to FileMaker Migration Procedure - 14



Step 2 - MySQL to FileMaker - Create Tables in FileMaker Pro

Enable Security & Privacy - Accessibility for FmPro Migrator (macOS)

[ < Y Security & Privacy Q

General FileVault Firewall

Calendars Allow the apps below to control your computer.

U Reminders
S . AEServer
*

Photos
0 | # FmPro Migrator 9.37 DE.app

.! Camera
Microphone
W @ Kitematic (Beta)

GoToMeeting v10.17.0

g

W Speech Recognition o
+ —
@ Accessibility @
Input Monitoring
Full Disk Access
§é’ Click the lock to prevent further changes. Advanced... ?

On macOS, FmPro Migrator will attempt to automatically open the FileMaker Manage Database
window using AppleScript. FmPro Migrator needs to be enabled under the Accessibility section of
the Security & Privacy section of System Preferences.

(1) Unlock preferences to allow changes, (2) click the Accessibility item then (3) click on FmPro
Migrator so that it has a checkmark next to its name. (4) Click the lock button again to insure that
the changes are updated.

If FmPro Migrator isn't enabled under the Accessibility preferences, you can always open the
Manage Database window manually.
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Click Copy All Tables to Clipboard Button

Migration Process
TOs  Value Lists CFs Layouts  Scripts GUI

o Servts
AL =

Original Table __NewTable _____Source™®Destination _Filds _[Recor: |
63

address_book address_book MySQL FileMaker 19
asset_management2 |asset_management2 |MySQL

IELIESE  Relationships

Step 2:
Install the FileMaker
ODBC driver.

companies

' ies 2
Create an ODBC comnanies

DSN matching the
DSN name listed in
the Table Details

) Original Fieldname PK |Auto-Increment |Next SN New Fieldname |

window. 1 middle_name middle_name
2 phonetic_last_name phonetic_last_nam

Turn on ODBC 3 name name
Sharing within 4 organization organization
FileMaker. 5 denartment department
Menu: File > Sharing
> ODBC/JDBC
Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Create Table Transfer Data

Not Started

Not Started

FmPro Migrator will copy the FileMaker table creation XML code onto the clipboard, ready for
pasting into FileMaker Pro. The status menu of the Step 2 button will change from Not Started to
Completed.
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FileMakerDB.fmp12 Created & Opened

@& FileMakerDB.fmp12
MigrationPreferences.dat
& MigrationProcess.db3

Since the conversion type is from MySQL into FileMaker Pro, an empty FileMakerDB.fmp12 file will
be created in the output directory and opened automatically.

Accessibility Permissions Dialog - macOS

“FmPro Migrator 9.37 DE.app” wants
D access to control “System Events.app”.
@ Allowing control will provide access to
documents and data in “System
Events.app”, and to perform actions within

that app.

: Dort Alow

FmPro Migrator will attempt to open the Manage Database dialog within FileMaker Pro. Click the
Ok button in the access control dialog to permit FmPro Migrator to control the FileMaker

application.
You wii need to click the Copy All Tables button again after clicking the Ok button in this dialog.
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Paste Tables into FileMaker Pro

Manage Database for “FileMakerDB"

Fields  Relationships

A table is a unique set of records and fields. A file can contain more than one table.
1 table defined in this file

View by: | creation order B
Table Name Source Details Occurrences in Graph
4 = Placeholder TO FileMaker 1 field, O records = Placeholder TO
Table Name: I= Placeholder TO I Create Delete
Copy Import...
? Print... Cancel “

Click the Paste button to create the tables within the FileMaker database.
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Tables Created in FileMaker Database

Manage Database for “FileMakerDB"

A table is a unique set of records and fields. A file can contain more than one table.

21 tables defined in this file

Table Name
asset_management2
contacts
contacts_uuid
members
contact_management
tbl_maintenance_recor...
members_3
companies
address_book
locationtest

tokens

tbl_assets_v1

@ O O 6 6 O O O b 6 O O o

users

Source
FileMaker

FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker
FileMaker

Relationships

Details

42 fields, 0 records
42 fields, 0 records
13 fields, O records
17 fields, O records
43 fields, 0 records
29 fields, 0 records
17 fields, O records
5 fields, O records
63 fields, O records
4 fields, 0 records
5 fields, O records
5 fields, O records
12 fields, O records

Occurrences in Graph
asset_management2
contacts
contacts_uuid
members

contact_management

tbl_maintenance_records

members_3
companies
address_book
locationtest
tokens
tbl_assets_v1
users

Table Name: I|

I Create

? Print...

Copy

The new tables will be displayed in the Manage Database window.

Paste

Cancel

View by: | creation order B

Delete

Import...
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Step 3
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Install FileMaker ODBC Driver - Windows - FileMaker 11+

Install the FileMaker ODBC driver from within the xDBC folder on the installation CD or CD image
file.

Create ODBC DSN - Windows

Organize v Burn =~ 0 @ |
X Favorites Name : Date modified Type Size

Bl Desktop (2= Component Services 7/13/20099:09 PM  Shortcut 2KB
& Downloads A 7/13/2009 9:08 PM  Shortcut 2KB
=] Recent Places 7/13/2009 9:08 PM Shortcut 2KB
B [ MaTntains ODBC data sources and drivers. }’tCUt 2KB
4 Libraries @, iSCSI Initiator 7/13/2009 9:08 PM Shortcut 2KB
= Documents [@ Local Security Policy 6/5/2011 9:50 AM Shortcut 2KB
J’ Music @ Performance Monitor 7/13/2009 9:08 PM Shortcut 2KB
=/ Pictures Egl Print Management 6/5/2011 9:49 AM Shortcut 2KB
(5 [a); Services 7/13/20099:08 PM  Shortcut 2KB
(7 System Configuration 7/13/20099:08 PM  Shortcut 2KB
1% Computer @ Task Scheduler 7/13/2009 9:09 PM Shortcut 2KB
& Local Disk (C:) @ Windows Firewall with Advanced Security ~ 7/13/2009 9:08 PM Shortcut 2KB
¥ FileMaker_xDBC_Up Windows Memory Diagnostic 7/13/2009 9:08 PM Shortcut 2KB
5® share on 'psf' (X:) @ Windows PowerShell Modules 7/13/2009 9:51 PM Shortcut 3KB

5 Home on 'psf' (V:)
5® Host on 'psf' (Z:)

“ﬂ Network

' lditems

-
M
v

{

. " _— _ — ——™ — - ""——————__—_—_—_—_—_—_——

To create a new System ODBC DSN, open the Control Panel > Administrative Tools > Data
Sources (ODBC) Control Panel.
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e

System Data Sources:

Name Driver
m Microsoft Access Driver (*mdb, *accdb)

example_fmp_dsn10 DataDirect 32-BIT Sequelink 5.5
example_fmp_dsn11 FileMaker ODBC

~. An ODBC System data source stores information about how to connect to
5 the indicated data provider. A System data source is visible to all users
on this machine, including NT services.

Ok || Cancel || ooy || Help

(1) Click the System DSN tab, then (2) click the Add button.

Select ODBC Driver - FileMaker 11 - Windows

! Select a driver for which you want to set up a data source. I

Name

Driver do Microsoft Paradox (*.db )
Redaspass-addiasacoft Visual FoxPro

FileMaker ODBC

-~ -
>

[

FileMaker Pro
FileMaker SQL Server Driver
FileMaker Text Driver (*.%)

EUE S IS B S }

e oA InAAE M-

< L)

(1) Select the FileMaker ODBC driver, then (2) click the Finish button.
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ODBC Driver Configuration - FileMaker 11+ - Windows (1)

FileMaker DSN Configuratio S|

The FileMaker ODBC assistant helps you configure your ODBC driver
and connections.

| About.. |

You will be prompted for the host address and database name.

To configure your data source, dick the Next button.

ODBC for
FileMaker

Click Next button.
Click the About button if you need to find the version number for the driver.

ODBC Driver Configuration - FileMaker 11+ - Windows (2)

FileMaker DSN Configurati (S

This assistant creates an ODBC data source that you can use to
connect to your database.

What name do you want to use to refer to the data source?

Named example_fmp_dsni1

How do you want to describe the data source?

Description: ~ FileMaker 11 DSN|

ODBC for
FileMaker

<A 2 [ vee> ) rmn [ conce

1) Enter a name for the ODBC DSN, (2) click the Next button.

FmPro Migrator - MySQL to FileMaker Migration Procedure - 23



ODBC Driver Configuration - FileMaker 11+ - Windows (3)

FileMaker DSN Configuratio|

Which host do you want to connect to?

O Host: localhost

The host is typically referred to by its IP address.

If the database is on this computer, enter localhost.

‘ @ Connect to host to obtain the names of available
databases.

ODBC for
FileMaker

1) If you are using a local copy of FileMaker Pro or FileMaker Pro Advanced, then use "localhost"
as the host name. Otherwise use the IP address or hostname of the FileMaker Advanced Server.
2) You may optionally click the "Connect to host ..." button to get a list of database files.

3) Click the Next button.
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ODBC Driver Configuration - FileMaker 11+ - Windows (4)

Which database do you want to connect to?

o Database: Default

If your application requires spedal handling of non-English text, dick

0=

Advanced Language.

["| Describe text fields as long varchar

[~ save long running queries to a log file:

ODBC for
FiIeMaker Long query time (miliseconds): | 5000

| <Back || mext> | | Finish || cancel |

1) Enter "Default" as the database name. Or if you have multiple database files open locally or on
the server, then select the database name from the list or enter the name of the database. Using
the Default keyword means that you can avoid changing the setup of the ODBC DSN when using
different database files - but it means that only one file can be open ata time.

2) Click the Advanced Language button.
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ODBC Driver Configuration - FileMaker 11 - Windows (5)

Advanced Language Options X

These options affect the way non-English characters are handled by the
driver.

G [ ] Auto-detect language settings for application

© Misre textenodig

O =) o

1) Uncheck the "Auto-detect language settings" button, 2) select System (WinLatin1) for the text
encoding, 3) click the Ok button.

It has been found that for proper character encoding, the following configuration works well:

1) Install the FileMaker database and FmPro Migrator on Windows. If using a 64-bit version of
Windows, use the ODBC Administrator - 32 bit (not the 64 bit) to create your ODBC DSN when
using FileMaker Pro or FileMaker Pro Advanced.

2) In the FileMaker ODBC driver, disable the Auto-Detect Language checkbox in the Advanced
Language dialog.

3) Set the Multi-byte Text Encoding menu to UTF-8 in the Advanced Language dialog.

4) Enable the Perform Translation for Character Data checkbox on the last panel of the SQL
Server ODBC DSN configuration.
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ODBC Driver Configuration - FileMaker 11+ - Windows (6)

FileMaker DSN Configurati E

Which database do you want to connect to?

Database: Default

If your application requires spedal handling of non-English text, dick
Advanced Language.

[Advanced Language... ]

["| Describe text fields as long varchar

Save long running queries to a log file:

ODBC fOI’ ‘ ‘ Browse...
FiIeMaker Long query time (milliseconds): . 5000 ‘

<Back f| nNext> |J| Fiish || cancel

Click the Next button.

ODBC Driver Configuration - FileMaker 11+ - Windows (7)

FileMaker DSN Configurati [

The ODBC data source has the following configuration:
FileMaker ODBC Driver (32-bit) 11.3.76.0

Data Source Name: example_fmp_dsn11
Description: FileMaker 11 DSN

Host: localhost

Database: Default

Use Long Varchar Type: No

Auto-detect Language Settings: No
Multi-byte text encoding: UTF-8

Log Long Running Queries: No

ODBC for
FileMaker

| T .

Click the Test button.
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ODBC Driver Configuration - FileMaker 11+ - Windows (8)

FleMakerlogin (U s
Data Source Name: example_fmp_dsn11 Q

' User ID:  Admin
l Password:

I

1) Enter Username, 2) Password (if needed), 3) click the Ok button.

Review the test results, make corrections as necessary until the test passes.

ODBC Error Troubleshooting Steps:

1) Verify that the FileMaker database file is open.

2) Verify that ODBC sharing is enabled for the account entered in the connection test dialog
prompt.

3) Make sure that there aren't two different copies of FileMaker running at the same time. Both
older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type
of conflict occurs, close both versions of the FileMaker application, and only open the one copy
you want to serve the database file being migrated.

4) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog).
Then testthe DSN again after rebooting.

ODBC Driver Configuration - FileMaker 11+ - Windows (9)

Which database do you want to connect to?

Database: Default

If your application requires spedcial handling of non-English text, dick
Advanced Language.

[ Advanced Language... ]
g [ | Describe text fields as long varchar

("] save long running queries to a log file:

ODBC for
FileMaker Long query time (miliseconds): | 5000

< Back H Next > ] Cancel

Click the Finish button.
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Install FileMaker ODBC Driver - macOS (FileMaker 11+)

Download ODBC Manager

‘0 O Mac OS X: ODBC Manager

[
< | > + o3 http://www.odbcmanager.net/ ¢ | (Q Google
[ ## Google Voice - Contacts Comcast TV ...D | Fancast Kagi - .com Solutions Inc. Google Finance Dotcomsoluti...ionsinc.net »

ODBC Manager

The free ODBC administrator for Mac OS X
Download ODBC Manager 1.0.5

Replaces ODBC Administrator omitted from
Snow Leopard

1.3 MB | Universal Binary

Requires Mac OS X 10.4 or later

Easy to install - just drag to the Utilities folder

Works great with most drivers Made for Snow Leopard

Freely re-distributable - include it with your
application package

ODBC Manager is freeware. Questions? contact support@odbcmanager.net

Download and install the free ODBC Administrator for macOS from www.odbcmanager.net

You will use the ODBC Administrator to create and manage your ODBC DSNs on macOS.
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Install the FileMaker ODBC Driver

FileMaker Pro 11 Advanced

P 4 1 of 4 selected, 604.8 MB available (O

FileMaker Pro 11 Advancec

Y xDBC
Open the 2 4 items, 604.8 MB available

xDBC Folder M.
» | ] JDBC Client Driver Installer

[ ] ODBC Client Driver Installer
a B FileMaker ODBC.mpkg @

[¥| Readme.pdf

xDBC

(1) Open the xDBC folder on the FileMaker install CD (or installerimage DMG file).
(2) Double-click the FileMaker ODBC.mpkg installer to install the FileMaker ODBC driver. Follow
the insular prompts.
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Add a System DSN

8006 ODBC Manager
Us 0 n i System DSN § Drivers = Tracing = Connection Pooling = About 1
Name Description Driver '
example_acs_dsn Actual Access @ Add...
example_fmp_dsn FileMaker 9 ODBC
-
example_fmp_dsn7 FileMaker 9 ODBC
FMSR_DSN SQLite ODBC ... Actual Open Source Databases
frontbase_dsn FrontBase
mysql_dsn Actual Open Source Databases
openbase_dsn Actual OpenBase
oracle_dsn Actual Oracle
pg_pv360_dsn PostgreSQL o... Actual Open Source Databases
pv360_oracle_dsn Actual Oracle
sqlserver2_dsn Actual SQL Server
sqlserver_dsn Actual SQL Server ~
sybase_dsn Actual SQL Server
test_acs my database Actual Access
(1) Click the System DSN tab, then (2) click the Add button.
Choose the FileMaker ODBC Driver
N.O0.O ODBC Manager
(A Uers N
< (kjoose a driver: v
T 4 Driver
Name Actual Oracle B
::Z: Actual SQL Server
ilo o AWATaT: h
exam -/
EMSR FiIeMaker ODBC H —_—
front Y _ JUE \—
mysq | SQLite3
open
1
2 Comi (o)
pv36
sqlserver2_dsn Actual SQL Server ['I
sqlserver_dsn Actual SQL Server
sybase_dsn Actual SQL Server ) §
test_acs my database Actual Access v
4

(1) Select the FileMaker ODBC driver from the list, (2) click the Ok button.
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FileMaker ODBC DSN Configuration - Page 1

FileMaker DSN Configuration

[N Introduction

@ Introduction The FileMaker ODBC assistant helps you manage your ODBC driver

Data Source and connections.

Connection ( About... )
Database

T e You will be prompted for the host address and database name.

.\ To configure the data source, click the Continue button.

ODBC for
FileMaker

Click the Continue button.
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FileMaker ODBC DSN Configuration - Page 2

FileMaker DSN Configuration

Enter the data source name and description

O Intr ion . .
troductio This assistant creates an ODBC data source that you can use to

© Data Source connect to your database.

© Connection

What name do you want to use to refer to the data source?
Database
. Name: § example_fmp_dsn11
Conclusion

How do you want to describe the data source?

Description:

Ly
ODBC for
FileMaker

( Cancel )( Finish ) Co Back /.

(1) Enter a name for the FileMaker ODBC DSN. The name used here needs to be exactly the same
as the ODBC DSN Name you enter into FmPro Migrator.

(2) Click the Continue button.

Note: You can pick a different name than you see here, just make sure that you enter exactly the
same name into FmPro Migrator.
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FileMaker ODBC DSN Configuration - ODBC DSN Field in FmPro Migrator

/Users/dsimpson/Desktop/Access_To_FM/

In this screenshot, the FileMaker 11 database is the destination database, therefore the FileMaker
ODBC DSN name is entered in the Destination Database ODBC DSN field.

If the FileMaker database was the source database, and the data was being copied to a different
database server, then the FileMaker ODBC DSN would be entered into the ODBC DSN field for

the Source Database (not shown in this screenshot).
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FileMaker ODBC DSN Configuration - Page 3

FileMaker DSN Configuration

Enter the connection information

) i .
Introduction Which host do you want to connect to?

© Data Source
© Connection
0S typredlly referred to by its IP address.

Database

- If the database is on this computer, enter localhost.
Conclusion

[ Connect to host to obtain the names of available databases.

<
ODBC for
FileMaker

N Fini ) (
( Cancel ) Finish ) ( Go Back

o

(1) Enter the hostname for the FileMaker database (defaultis localhost).

(2) Click the Continue button.

For a file which has been opened on your local desktop machine, leave the default setting of
localhost.

For a hosted file hosted by FileMaker Server Advanced, enter the IP Address or hostname of the
FileMaker Server Advanced computer.
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FileMaker ODBC DSN Configuration - Page 4

FileMaker DSN Configuration

Enter the database information

) i .
Introduction Which database do you want to connect to?
© Data Source O j
Database:§ Default ”
© Connection
© Database e . . . .
If your application requires special handling of non-English text,
Conclusion click Advanced Language.

o Advanced Language... )

(| Save long running queries to a log file:

.\ Choose...
ODBC for Long query time (milliseconds): 5000
FileMaker

C Cancel ) ( Finish ) ( Co Back ) ( Continue )

(1) For most locally hosted database files, enter the text "Default” into the Database field, instead of
selecting a database from the list. This way you can use any single database file without
re-selecting the database name each time you open a new file.

To use this feature, you must only have one FileMaker database file open at a time, or an error will
occur when attempting to read info from the database.

(2) Click the Advanced Language button.
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FileMaker ODBC DSN Configuration - Page 5

FileMaker DSN Configuration

Introd
Data

These options affect the way non-English characters are handled by
the driver.

| Auto-detect language settings for application
| Application uses the "wide" ODBC API

Connect
Treat text types a e
Databasé System (MacRoman) bh text,
Conclusi Multi-byte text enc
J |uage...
(Cancel{ 3)
t" Choose...
ODBC fOf' Long query time (milliseconds): 5000
FileMaker
Cancel Finish Go Back Continue

(1) Un-check the Auto-detect language settings checkbox.
(2) Select UTF-8 from the Multi-byte text encoding menu.

(3) Click the Ok button.
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FileMaker ODBC DSN Configuration - Page 4

FileMaker DSN Configuration

Enter the database information

(S i .
Introduction Which database do you want to connect to?

© Data Source

Database: Defaul
© Connection [ d ﬂ
(]
N If your application requires special handling of non-English text,
Conclusion click Advanced Language.

(Advanced Language... )

(| Save long running queries to a log file:

.\ Choose...

ODBC fOl’ Long query time (milliseconds): 5000
FileMaker

( Cancel )( Finish ) Go Back fzeontmue:)

(1) Click the Continue button.
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FileMaker ODBC DSN Configuration - Page 5

FileMaker DSN Configuration

Conclusion

R The ODBC data source has the following configuration:

Data Source
FileMaker ODBC Driver 11.0.58

()

()

© Connection
Data Source Name: example_fmp_dsnll

()

()

Database Description:
. Host: localhost
Conclusion Database: Default

Auto-detect Language Settings: No
Application Uses "Wide" API: No
Treat Text Types as Unicode: No
Multi-Byte Encoding: UTF-8

Log Long Running Queries: No

ODBC for
FileMaker

{\ Cancel J. ( Go Back )( Done )

(1) Click the Test button.
If the test fails, use the following steps to enable ODBC sharing for the FileMaker database.
Note: Each FileMaker database needs to have ODBC sharing enabled individually.

FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

FileMaker Login

Data Source Name: example_fmp_dsnll

e (Crre—| O

Enter the (1) Username, (2) Password, then (3) click the Ok button to test the ODBC DSN.
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FileMaker ODBC DSN Configuration - Page 5 - ODBC DSN Test

Test Results:
Attempting to connect to database Default on host localhost...
Database version: FileMaker 11.0.2

Test completed successfully.

0=

(1) Click the Ok button.
If the test passes, this dialog will be displayed, showing that the ODBC Driver Manger has used
this ODBC DSN to successfully connect to the FileMaker database.

If the test fails:

1) Verify that the FileMaker database file is open.

2) Verify that FileMaker ODBC sharing is enabled for the account entered in the connection test
dialog prompt.

4) Make sure that there aren't two different copies of FileMaker running at the same time. Both
older and current versions of FileMaker use TCP/IP Port# 2399 for ODBC connectivity. If this type
of conflict occurs, close both versions of the FileMaker application, and only open the one copy
you want to serve the database file being migrated.

5) Try rebooting the computer (after clicking Ok to save changes and close this ODBC dialog).
Then test the DSN again after rebooting.
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FileMaker ODBC DSN Configuration - Page 5

FileMaker DSN Configuration

Conclusion

= il The ODBC data source has the following configuration:
© Data Source
FileMaker ODBC Driver 11.0.58
© Connection
Data Source Name: example_fmp_dsnll
© Database Description:
§ . Host: localhost
© Conclusion Database: Default

Auto-detect Language Settings: No
Application Uses "Wide" API: No
Treat Text Types as Unicode: No
Multi-Byte Encoding: UTF-8

Log Long Running Queries: No

Ly
ODBC for
FileMaker

C Gancel ) ( Test ) —

(1) Click the Done button to save the new ODBC DSN.
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Enable ODBC/JDBC Sharing within FileMaker Pro

New Database...

Open... #0
Open Remote... ¢ #¥0
Open Recent >
Close #W
Manage >

FileMaker Network...
Instant Web Publishing...
ODBC/JDBC...

Sharing

File Options...
Change Password...

Page Setup...
Print... £

Import Records >
Export Records...

Save/Send Records As >
Send Mail...

Send Link...

Save a Copy As...

Recover...

ODBC/JDBC Sharing needs to be enabled within any FileMaker Pro database file which is going
to be used with the FileMaker ODBC driver.
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Select Sharing Parameters

FileMaker ODBC/JDBC Settings

ODBC/JDBC Settings
Turn on ODBC/JDBC Sharing to publish all shared open files using this protocol.

ODBC/JDBC Sharing: O om

File access via ODBC/JDBC

rrently open files
m— ODBC/JDBC access to file

FileMakerDB.fp7 File: FileMakerDB.fp7

@ @ All Users

() Specify users by privilege set

)
No users
(_Cancel ! ——————

(1) Turn on ODBC/JDBC Sharing, (2) for the currently open FileMaker Pro database file, (3) for All
Users, then (4) click the Ok button.
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Step 3 - MySQL to FileMaker - Transfer Data

Click Step #3 - Transfer Data Button

Migration Process
Value Lists CFs Scripts GUI

”ﬂam%f

JELIEEM  Relationships TOs Layouts

Step 2:
Install the FileMaker

ODBC driver. .
companies

K iag 2
Create an ODBC comnanies

DSN matching the
DSN name listed in
the Table Details
window.

PK |Auto-Increment |[Next SN New Fieldname
middle_name
phonetic_last_nam

middle_name

Turn on ODBC
Sharing within
FileMaker.

Menu: File > Sharing
> ODBC/JDBC

Click the Get
FieldSize icon.

Troubleshooting:
Make sure the
specified ODBC DSN

Create Table
Completed

Transfer Data
Not Started

If you have already opened the new FileMakerDB.fmp12 database file and configured the ODBC
DSN for the FileMaker Pro database, just click on a table in the list of tables then click on the Step
#3 Transfer Data button in the Migration Process window.
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Repeat this process for each imported MySQL table.

ODBC DSN Error - Connecting to FileMaker Pro Database

If you getan ODBC DSN connection error, review the steps for installing the FileMaker ODBC
driver and creating the ODBC DSN for connecting to the FileMaker Pro database. The FileMaker
database must be open, and ODBC sharing needs to be enabled. Also, make sure that the name
of the ODBC DSN you entered into FmPro Migrator for the destination database matches the name

of the ODBC DSN you created.
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Imported Data in FileMaker

| NON ) FileMakerDB
> - 1 , ?c?tal ol O\ v 12 M v || Q- Search >
Records New Record Find Sort Share
Layout: [ members R e = = e A?
first_name last_name  home_addres... home_addres... city country
Andre Common 147 White Los Angeles USA AE
Steve Williams 789 Ninth New York USA AE
Kentaro >4 |Ogawa /\)I|  [2-23-5 Imachi Setagaya Tokyo Japan AE
Mary Smith 123 EIm St. New York USA DE
Marie Durand 1ruedela Paris France DE
Sophie Tang 126, Deepwater Kowloon Hong Kong DE
Juanita Alvarez 147 Houston New York USA DE
William Johnson 852 Marsh Road London UK DE
Annelies Verhaag Blauwburgstraat Amsterdam Netherlands DE
Juan Garcia Calle Real Colonia Mexico Df Mexico DE
Sven Svensson Klammerdamms Stockholm Sweden DE
Jacques Dupont Rue des Alpes Lausanne Switzerland DE
A. N. Other The Cottage Mayflower Lane [Bristol UK DE
Bengt Larsen Vogts gate 33 Oslo Norway DE
Michelle Cannon 123 4th St. SW Edmonton Canada XY
John Smith 41 Mary St Sydney Australia XY
Patrick Murphy 89 Lavenworth [Castleknock Dublin Ireland XY
.Jean Durand 1001 place du Montreal Canada XY

After transferring the data into the FileMaker database it can be displayed like any other table. This
screenshot shows a sample table containing UTF-8 data for the 3rd record having been imported
and displayed correctly.

When FmPro Migrator connects to a MySQL database server, it sets the character setto UTF8MB4
to insure that all unicode characters are transferred correctly.
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UTF8MB4 MySQL Database Configuration

O () Edit Schema

Database Name: |test
Character Set: | utf8Smb4

Collation: |utf8mb4_unicode_ci

If unicode characters aren't being transferred properly, the character set encoding could be the
cause of the problem. You could test setting up the database character set as shown in this
screenshot of the Navicat Edit Schema dialog. This dialog is accessed via right clicking on the
database name in the list of databases, then selecting Edit Database from the contextual menu

which pops up.
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